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CAD-CAM-CAE Példatár 
 
A példa megnevezése: CAD-modellezés, összetett alkatrész (ipari rajz 

alapján) 
A példa száma: ÓE-B03 
A példa szintje: alap – közepes – haladó 
CAx rendszer: CATIA V5 
Kapcsolódó TÁMOP tananyag rész: CAD 
A feladat rövid leírása: Készítsük el az alkatrész modelljét és alkatrészrajzát 

is.  

 
1. A feladat megfogalmazása: 
 
Készítse el az alábbi alkatrész modelljét! 
 

 
 
2. A megoldás lépései: 

  
2.1. A kiinduló henger elkészítése 

A kezdeti Sketch-ben egy  Ø90-es kört rajzolva az origóba, majd kilépve onnan, a Pad  
parancs segítségével létrehozunk egy hengert 73 mm hosszon. 
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2.2.  A felső konzol elkészítése 

 
Feladatunk során talán a legnehezebb feladatunk ezzel a résszel adódik, ugyanis láthatóan a 
metszetében kapunk geometriai adatokat, amik jó kiindulást jelentenek, de a többi nézetből 
felmerül pár apróbb kérdés a modellezést illetően. Miután alaposan szemügyre vettük a 
darabot, láthatunk a szemből nézeti képen egy 86mm-es távolságot, amelyet felhasználunk 
ahhoz, hogy a középtengelytől milyen távolságra kell elkezdenünk az oldalprofil 
megrajzolását.  
A konzol felső, furatokkal ellátott része láthatóan egy hengeres alakzat, ezt mi is ebből az 
irányból közelítjük meg és utólag szerkesztjük meg.  

 

 
 
Első lépésként kiszámítjuk, hogy az elölnézeten található 86 mm-es hossz- ahonnan 
lényegében szűkülni kezd a profil- milyen távolságra van a hengerfelülettől. Ezen kiszámolt 
távolságban ( 41,845 mm) elhelyezünk egy síkot a Plane  parancs segítségével, az Offset 
the Plane típust választjuk ki és megadjuk a referenciasíkot, amitől a távolságot számítottuk. 
Miután elkészültünk a képen látható síkon elkészítjük az oldalnézeti Sketch-et, mint látható ez 
a rajzunkhoz képest csonka, ugyanis az előbb taglalt módon a hengeres részt majd ezután 
szerkesztjük rá. A vastagabb párhuzamos résszel csak annyi a dolgunk, hogy szemre 
megfelelő hosszú legyen, később még természetesen bele lehet szerkeszteni. 

Ha elkészültünk a Sketch-csel, akkor kilépve a Pad  parancsot választva kihúzzuk a 
profilt. Mivel a szerkesztés síkja középen helyezkedett el, ezért két irányba kell kihúzni, a 
First és a Second Limit is ugyanakkora, 43 mm. 
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Mint látjuk, ezzel még csak közelítünk a kívánt profilhoz. Itt ismét egy kis számolásra lesz 
szükség, ugyanis az előbb szerkesztett profilunk falait meg kell döntenünk, hogy a kívánt 
szélességben -55 mm- találkozzanak a hengeres fejrésszel. A számolást elvégezve megkapjuk, 
hogy 7,81 fokot kell döntenünk a falakon, hogy az adott magasságban és távolságban ezt a 

szélességet adják. A falak megdöntéséhez a Draft Angle  parancsot fogjuk használni. 
 

 
 
Beírjuk a szöget, majd a Face(s) to Draft –on belül kiváűlasztjuk a két megdönteni kívánt 
falat, végül a Selection sorban a merőleges síkot. 

 
Miután elkészültünk most elkészítjük a hengeres fejrészt.      Mivel ahhoz, hogy körből 
kiindulva szerkesszünk egy elég bonyolult módon elhelyezhető síkot kéne elhelyeznünk, ezért 
egyszerűsítve a feladaton a hengert másik irányból megközelítve, egy négyszöget fogunk 
megforgatni. 
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Tehát létrehozzuk az képen látható Sketch-et, egyszerűen csak egy helyesen pozícionált 

négyszöget, majd a 3D-s modulba visszalépve a Shaft parancs segítségével 
megforgatjuk. Így megkapjuk a kívánt profil, láthatóan ez előbbiekben szerkesztett, majd 
megdöntött profil egybeolvad a hengerrel. 

 

 
 
A konzol alapprofilja elkészült, láthatóan még a furatok létrehozása lesz a feladatunk, de ezt 
csak a feladatunk vége felé haladva tesszük majd meg. 
 
2.3.   Az alsó konzol elkészítése 
 
A rajzon is jól látható, hogy az alsó konzol is hasonlóan épülhet fel, mint a felső ,csupán a 
geometria különbözik és a hengeres rész méretei. 
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Tehát az előzőhöz hasonlóan, itt is létrehozzuk a síkot, amely 41,845 mm távolságban van a 
középsíktól, majd pedig egy új Sketch-ben felrajzoljuk a profilt. Ezután kilépünk a Sketch-

ből, majd a Pad  parancs segítségével itt is két irányban kihúzzuk a profil 43-43 mm 
távolságra (ez most nincs képen illusztrálva, mert nagyon hasonló a felső 
konzoléhoz).Hasonló számításokat végezve itt 7,24 fokos döntést számítunk, majd Draft 

Angle  paranccsal megdöntjük a profil falait, síkként itt is ugyanazt választjuk ki, mint az 
előzőekben. 
Ezután létrehozzuk egy új Sketch-ben  a hengeres rész négyszögprofilját és kilépve a Shaft

 parancs segítségével megforgatjuk. 
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2.4. A „fülek” elkészítése 
 

Csak az egyik fület kell megszerkesztenünk, mert a Mirror  parancs segítségével 
egyszerűen tükrözhetjük a tengelyekre a megszerkesztett fület. A megadott rajzról 
természetesen minden méret leolvasható és a fül egyszerűen megszerkeszthető. Miután 
megrajzoltuk a fület, először kijelölve azt, majd a Mirror parancsra kattintva ,végül a 
tükörtengelyre át is tükröztük fület. Eddig még csak két fül van meg, tehát kijelöljük ezt a 
kettőt, majd ezeket tükrözzük a másik tengelyre, így megkapjuk a négy fület. Előfordulhat, 
hogy a kényszerek közül nem mind tükröződik, ezen esetben meg kell ismételni egy-két 
kényszer definiálását. 

 

 
 

Az eddig is gyakran felhasznált Pad  parancs segítségével kihúzzuk a füleket 18 mm 
mélységben. 
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2.5. A nagy furat elkészítése 
 

Már jól ismert módszerrel létrehozunk egy átmenő furatot a Hole  parancs segítségével. 
Up to Next típust válasszunk, tehát a következő felületig tart. 

 

 
 

2.6. A belső beszúrás elkészítése 
 

Egyszerűen egy helyesen elhelyezett négyszög segítségével kivágjuk a beszúrást. Ha az adott 

síkon megvan a Sketch, akkor Groove  parancs segítségével megforgatjuk és el is készült. 
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2.7. A szűkítés elkészítése 
 

Hasonlóan a beszúráshoz , ezen esetben is egy négyszöget helyezünk el, csupán itt a Shaft 

 paranccsal forgatjuk meg, így nem kivágjuk, hanem hozzáillesztjük az anyagot. 
 

 
 

2.8. Furatok elkészítése 
 
Mint látható a modell nagyjából kialakulóban van, már csak a kisebb simítások és a furatok 
létrehozása van hátra. 

 
2.8.1.  Az Ø37 –es átmenő furat 
 

A két konzol valamelyik külső oldalára kattintunk, miután kiválasztottuk a Hole  
parancsot. Két dolgot kell meghatároznunk: az átmérőt és az Up To Surface típust. Ezen típus 
esetében meg kell adnunk azt a felületet, ameddig tart a furat, ehhez kijelöljük a másik konzol 
túloldalát és el is készültünk. 
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2.8.2. A fülek furatainak elkészítése 
 

Extension->Up to Next 
Thread Definition->Dimension 
Type->Metric Thick Pitch (M12) 

 
Ezen beállításokkal kell létrehoznunk a furatot, miután pozícionáltuk a Positioning Sketch-en 

belül. Természetesen ezt sem kell egyenként beállítanunk, a Rectangular Pattern   
paranccsal kioszthatjuk a furatokat, amelyet csak egyszer kell konfigurálni. A First Direction 
fülön belül az 1-es nyíl irányába mutató távolságot és osztás tudjuk megadni, a Second 
Direction fülön a 2-es nyíl irányába mutatót. Esetünkben az 1-es nyíl irányába 108 mm, a 2-
esébe 76,2 mm távolságot kell beállítani. Típus mindkét esetben Instance &Spacing ( osztás 
száma egy irányba és távolság szerint),az Instance (osztás száma egy irányba) pedig 2. 

 

 
 

 
 

2.8.3. A felső konzol furatai 
 
Extension->Up to Next 
Type->Counterbored 
Thread Definition->Dimension 
  Metric Thick Pitch->M12 

 
Ezen beállításokkal tudjuk létrehozni a kettős furatot, amelyet az előzőekhez hasonlóan egy 
kör mentén kioszthatunk, hogy ne kelljen újra megszerkeszteni. Ezt ebben az esetben a 

Circular Pattern  paranccsal tehetjük meg. 
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Itt 180 fokos kiosztásban dolgozunk és referenciafelületként (Reference Element ) a belső 
furatot kell megadnunk. A másik típusú furat, amely ezen a felületen van, azt ugyanezzel a 
módszerrel kell elhelyeznünk, csupán az a különbség, hogy a furat típusának megadásakor 
nem Counterbored, hanem Simple típust kell válasszunk. 

 
2.8.4. Az alsó konzol furatai 
 
Extension->Blind 
Type->Simple 
Bottom-> V-bottom 
Thread Definition -> 
  Type->Dimension 
  Metric Thick Pitch->M8 
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A furat fenti beállítások szerinti létrehozása után az előzőhöz hasonló Circular Pattern   
paranccsal egy kör mentén kiosztjuk a furatot. Egyértelműen 3x120 fokban osztjuk ki, a 
felkínált típusok közül az Instance & angular spacing-et kell kiválasztanunk. 
Referenciafelületként szintén a középső nagy furatot jelöljük meg. 

 

 
 

2.9. Lekerekítések hozzáadása 
 

Lekerekítéseket az Edge Fillet  paranccsal tudunk létrehozni. Mivel mindegyik szükséges 
lekerekítés ugyanakkora ( 10mm ), ezért egy parancson belül kijelölve az összes élet 
lekerekíthetjük azokat. 

 

 
 

  



CAD/CAM/CAE példatár  TÁMOP 4-1-2-08-2-A-KMR-2009-0029 

12 
 

2.10. Elkészült a modellünk: 
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3. Az alkatrészrajz elkészítése 
 

 
 

�Első lépésként el kell indítanunk a rajzoló modult a rendszerben , ezt 
ugyanúgy, mint minden más modult a Start menün keresztül tudjuk megtenni, 
tehát Start->Mechanical Design ->Drafting, eztuán a program megkérdezi, 
hogy mekkora méretű szabvány rajzlapon szeretnénk dolgozni, majd ha 
kiválasztottuk megjelenik az alábbi képernyő közepén a rajzlappal. 
 

    
 

 
Mint ismeretes a műszaki rajzdokumentációban a rajzlap rendelkezik egy 
szövegmezővel, de mint látható ezt a program nem kínálja fel automatikusan. A 
Catia rajzmoduljában egy háttérablak és egy főablak között lehet felváltva 
dolgozni, a keretet és a szövegmezőt a háttérablakban lehet kiválasztani, ennek 
előhívásához az Edit->Sheet Background fülre kell kattintani .A visszaváltáshoz 
a főablakba ugyanitt a Working Views –ra kel kattintani. 

 Ha beléptünk a Sheet Background ablakba, ott a Frame and Title Block  
ikonra kattintva tudjuk beállítani a szövegmező típusát. 
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 Miután kiválasztottuk a 
számunkra megfelelő 
típust, akkor egyszerűen a 
szövegmezőbe előre 
betáplált szövegek 
szerkesztésével át tudjuk 
alakítani azt, esetünkben 
elsődlegesen 
magyarosítani. Ezt 
befejezve a már előbb 
taglalt módon visszalépünk 
a Working Views ablakba 
és megkezdjük a tényleges 
rajzolást. Lényegében nem 

mi fogunk rajzolni, hanem különböző nézeteit hívjuk be az elkészített modellünknek, 
amelyeken méretmegadást és módosításokat tudunk végezni. 

  Ahhoz, hogy behívjunk egy nézetet először a Front View  ikonon belül lévő ikonok 
közül ki kell választanunk, hogy milyen nézetét kívánjuk behívni a modellnek. A rajzolások 
legnagyobb részét, ugyanúgy kezdjük el , mint a normál kézi rajzolás esetében, tehát 
kiválasztunk egy síkot és annak irányában rajzoljuk fel a darabunkat. Ennek végrehajtásához 
az előbb említett ikonra kell kattintanunk , majd a fejlécben a Window fülön belül kiválasztjuk 
a modellt, amiről szeretnénk rajzot készíteni ( természetesen a modellnek mindig nyitva kell 
lennie, enélkül nem tudjuk behívni).Itt a számunkra megfelelő síkra visszük az egeret, a 
programunk pedig behoz egy villámnézetet, így ellenőrizni tudjuk magunkat. Ha minden 
megfelelt akkor egyszerűen kattintunk egyet és a program azonnal átugrik a Drafting modulba 
és lehelyezi a modell a nézetben. 
 

 
 
A Drafting modulba helyezett nézetet még kívánságunk szerint elforgathatjuk a képen látható 
kurzorokkal, ha meg van a kívánt nézet, akkor egyet kattintva az elhelyeződik a rajzlapunkon. 
Ezek után tudunk méreteket és kisebb változtatásokat felvinni a nézetünkre, amelyek 
segítségével végül kialakul a kívánt rajzdokumentáció. 
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A konkrét modell rajza: 
 

 
 
Méretek megadása: 
- az alapvető méreteket a Dimensions ablakban és annak legördülő füleiben találhatjuk meg, 
ezek közül a fontosabbak: 

       -  Dimensions  (alapvetően hosszak megadása) 

       -  Diameter dimensions   ( átmérő megadása) 

       -  Angle dimensions  (szög megadása) 

       -  Chamfer dimensions  (letörések megadása) 

        -  Radius dimensions  (sugár megadása) 
   
- A tűrések megadásakor, először egyszerűen megadjuk a méretet, majd a fejlécen lévő 
Tolerance eszköztárban kiválaszthatjuk a tűrésmegadás típusát, majd értékét. Ez a megadása 
után automatikusan odakerül az előzőleg megadott méret mellé. 
 

- Alak- és helyzettűrések megadásához a Geometrical Tolerance  ikonra kell 
kattintanunk, ahol  felugró ablakban megadhatjuk a típust, az értéket és a referencia felületet. 

A referenciafelület megjelöléséhez válasszuk a Datum Feature  ikont, egyszerűen 
megjelölve a felületet különböző betűkkel vagy számokkal láthatjuk el.  
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1)Oldalnézet behívása 
 
A bevezetőben leírt módon behívjuk a modell oldalnézetét, majd ellátjuk a kívánt méretekkel  
és elvégzünk egy-két módosítást. 

Először is a metszet készítéséhez a Breakout View  ikonra kattintunk , majd egy folytonos 
vonallal körberajzoljuk az a részt, amelyen metszeti nézetet kívánunk létrehozni. Ezt a 
módszert alkalmazzuk, hogy lényegében félnézet-félmetszetet hozzunk létre ebben a 
nézetben, majd pedig, hogy az alsó konzolon megmutathassuk a furat típusát.  
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A különböző méretek megadásába felesleges részletesen belemenni , ugyanis a Dimensions 
ablakon belül minden egyes méretmegadási módot megtalálhatunk egyértelmű jelzésekkel. A 

felületi minőség megadásához válasszuk a  Roughness Symbol  ikont, ezen belül a bal 
oldali ablakban látható módon minden igényt kielégítő beállításokat tudunk végezni a 
szimbólum alakjára, méretére és típusára vonatkozólag. 
 

 
 
2) A szembőlnézet behívása 
 
Láthatóan ebben a nézetben nem kifejezetten sok méretet tudunk, illetve szükséges 
megadnunk, csupán pár távolság, illetve sugár megadására van szükség. 
Megjegyzendő még, hogy ha az adott nézetben középtengelyeket, tengelyvonalakat , illetve 
meneteket kívánunk megadni, akkor azt az aktivált nézet Properties ablakán belül tudjuk 
megtenni. A Properties ablak első fülén tudjuk kipipálni, hogy mely tulajdonságok láthatóvá 
tételét szeretnénk alkalmazni. 
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3) A konzolok nézetei 

 
 
A két konzol felülnézetét is az eddigiekhez hasonlóan behívjuk, majd a kívánt 
tengelyvonalakkal és menetekkel ellátva méretezzük. Ha vannak olyan méretek, melyek 
megadásához egyéb vonalakra lenne szükségünk, akkor ezt a rajzmodulban utólag is 
berajzolhatjuk . A modul Geometry Creation fülén belüli rajzeszközök segítségével. 
Értelemszerűen, ha más vonaltípusokra van szükségünk, akkor a vonalra kattintva , annak 
Properties menüjében ezt is megtehetjük.   
 

 
 
4) „A” metszet 
 
Ahhoz , hogy a felső konzol furatainak tulajdonságait megmutassuk , egy metszetet kell 

létrehoznunk a fent látható helyen az Offset Section View  parancs segítségével. Az 
aktivált nézetben egy egyenes vonallal kijelöljük a metszés síkját, majd elhelyezzük a 
metszetet.  
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Az elkészült rajz: 
 

 


